


Chapter 2: Building the Database  

 
TRUE/FALSE 

 

 1. Because reports store all of the data in a database, you must create them before any of the other 

database objects. 

 

ANS: F PTS: 1 REF: 107 

 

 2. In Design view, the Field Properties pane includes the Field Name, Data Type, and Description 

columns. 

 

ANS: F PTS: 1 REF: 110 

 

 3. Names of Access objects cannot contain numbers. 

 

ANS: F PTS: 1 REF: 110 

 

 4. Names of Access objects cannot begin with a space. 

 

ANS: T PTS: 1 REF: 110 

 

 5. The Description property is optional for a field. 

 

ANS: T PTS: 1 REF: 111 

 

 6. Literal characters supplied by an input mask are stored in the database.  

 

ANS: F PTS: 1 REF: 118 

 

 7. To accept the default value specified in the Default Value property, the user simply tabs through the 

field during data entry.  

 

ANS: T PTS: 1 REF: 122 

 

 8. Two tables have identical structures if they have the same number of fields and those fields have the 

same data types and field sizes.  

 

ANS: T PTS: 1 REF: 133 

 

 9. An AutoNumber record number that is used once can be used again in the same table if you delete the 

original record. 

 

ANS: F PTS: 1 REF: 134 

 

 10. After importing data into a new or existing table, you cannot change a field’s data type to 

AutoNumber. 

 

ANS: T PTS: 1 REF: 134 

 

 11. Access can import all data, including graphics, from an Excel worksheet.  

 



ANS: F PTS: 1 REF: 136 

 

 12. You can use Access to import specific data saved in an Excel workbook.  

 

ANS: T PTS: 1 REF: 136 

 

 13. A primary key and its foreign key counterparts must have the same data type and field size.  

 

ANS: T PTS: 1 REF: 141 

 

 14. A primary key and its foreign key counterparts can have different values.  

 

ANS: F PTS: 1 REF: 141 

 

 15. If referential integrity is set, a primary key value must exist before entering a corresponding record.  

 

ANS: T PTS: 1 REF: 141 

 

 16. A user can enter a null value into a primary key field. 

 

ANS: F PTS: 1 REF: 141 

 

 17. A primary key field and the corresponding foreign key field must have the same field name.  

 

ANS: F PTS: 1 REF: 146 

 

 18. The space created by deleting a record or object is automatically recovered for use by records and 

objects that users add to the database. 

 

ANS: F PTS: 1 REF: 156 

 

 19. Setting the Compact on Close option also repairs the database. 

 

ANS: F PTS: 1 REF: 156 

 

 20. A password is a collection of characters that a user types to gain access to a file.  

 

ANS: T PTS: 1 REF: 161 

 
MODIFIED TRUE/FALSE 

 

 1. When a database is designed, one of the most important functions is to make sure that the database 

stores the data in the correct format and outputs the correct formats and outputs the correct queries, 

forms, and reports for users. _________________________ 

 

ANS: T   PTS: 1 REF: 101 

 

 2. The Database window indicates the opened table’s name. _________________________ 

 

ANS: F, Table 

 

PTS: 1 REF: 108 

 



 3. You can use Design view to define the table’s fields and the field properties and rearrange the order of 

fields as necessary. _________________________ 

 

ANS: T   PTS: 1 REF: 110 

 

 4. If a field’s size is too small, data might be concatenated, or stopped after a certain number of 

characters. _________________________ 

 

ANS: F, truncated 

 

PTS: 1 REF: 111 

 

 5. You can create an input mask for fields by using the Input Mask Wizard, which guides you through the 

necessary steps for creating an input mask and lets you enter sample values to ensure the correct 

results. _________________________ 

 

ANS: T   PTS: 1 REF: 118 

 

 6. The input mask 00/00/0000;;_ accepts only digits, displays the literal characters, and ensures that users 

must enter two-digit months and dates, four-digit years, and complete dates. 

_________________________ 

 

ANS: F, does not display 

 

PTS: 1 REF: 119 

 

 7. A(n) input mask compares the data entered by the user against one or more valid values that the 

database developer specified using the Validation Rule property for the field. 

_________________________ 

 

ANS: F, validation rule 

 

PTS: 1 REF: 121 

 

 8. The Validation Text property enters a default value into any type of field except for an AutoNumber 

field. _________________________ 

 

ANS: F, Default Value 

 

PTS: 1 REF: 122 

 

 9. Access automatically assigns a data type to each column of data it imports by evaluating the data in the 

first 3 rows of the worksheet. _________________________ 

 

ANS: F, 25 

 

PTS: 1 REF: 136 

 

 10. In most cases, you will import the data stored in a single Excel worksheet, but you can also import 

named ranges of data. _________________________ 

 

ANS: T   PTS: 1 REF: 136 

 

 11. By default, nonprimary key fields can store null values. _________________________ 



 

ANS: T   PTS: 1 REF: 141 

 

 12. The default sort order for an index is descending. _________________________ 

 

ANS: F, ascending 

 

PTS: 1 REF: 143 

 

 13. A good rule of thumb is to schedule database compressions based on the amount of data loss that you 

can manage. _________________________ 

 

ANS: F, backups 

 

PTS: 1 REF: 158 

 

 14. Compacting a database creates a copy of the database that you can restore in the event of a loss. 

_________________________ 

 

ANS: F, Backing up 

 

PTS: 1 REF: 158 

 

 15. Revealing a hidden object is difficult to do. _________________________ 

 

ANS: F 

easy 

not difficult 

 

PTS: 1 REF: 163 

 
MULTIPLE CHOICE 

 

 1. All of the following are likely to be fields stored in a customer table in a pharmacy’s database 

EXCEPT ____. 

a. allergies c. date of birth 

b. prescription expiration date d. customer first name 
 

 

ANS: B PTS: 1 REF: 103 

 

 2. The ____ window is the main control panel for the database. 

a. Database c. Switchboard 

b. Table d. Object 
 

 

ANS: A PTS: 1 REF: 107 

 

 3. You must create ____ before any of the other database objects. 

a. reports c. data access pages 

b. queries d. tables 
 

 

ANS: D PTS: 1 REF: 107 

 



 

 

 4. The view of the data in the table in the accompanying figure is called ____ view. 

a. Database c. Datasheet 

b. Design d. Form 
 

 

ANS: C PTS: 1 REF: 108 

 

 5. The view in the accompanying figure shows the table’s ____ in rows. 

a. records c. attributes 

b. fields d. keys 
 

 

ANS: A PTS: 1 REF: 108 

 

 6. When you are working in a table, the window that opens is called the ____ window. 

a. Database c. Objects 

b. Table d. Datasheet 
 

 

ANS: B PTS: 1 REF: 108 

 

 7. ____ view shows the table’s records in rows and the table’s fields in columns. 

a. Table c. Datasheet 

b. Design d. Record 
 

 

ANS: C PTS: 1 REF: 108 

 

 8. The default name for a table that has not yet been saved is ____. 

a. New c. 1Table 

b. Table d. Table1 
 

 

ANS: D PTS: 1 REF: 108 

 

 9. After you enter the data into the first field in Datasheet view, you can press the ____ key and then 

enter the data for the next field. 

a. Enter c. F5 

b. Tab d. either a. or b. 
 

 

ANS: D PTS: 1 REF: 109 

 



 10. A datasheet has blank ____ for additional records. 

a. columns c. rows 

b. grids d. indices 
 

 

ANS: C PTS: 1 REF: 109 

 

 

 

 11. The accompanying figure shows a table in ____ view. 

a. Database c. Design 

b. Datasheet d. Form 
 

 

ANS: C PTS: 1 REF: 109 

 

 12. From Datasheet view, you can change to the view in the accompanying figure by clicking the ____ 

button in the Home tab of the Ribbon. 

a. Change c. Switch 

b. View d. Go To 
 

 

ANS: B PTS: 1 REF: 109 

 

 13. The top part of the view in the accompanying figure is called the ____. 

a. Table Design grid c. Objects bar 

b. Field Properties pane d. Groups bar 
 

 

ANS: A PTS: 1 REF: 109 

 

 14. The bottom part of the view in the accompanying figure is called the ____. 

a. Table Design grid c. Objects bar 

b. Field Properties pane d. Groups bar 
 

 

ANS: B PTS: 1 REF: 109 

 

 15. In the accompanying figure, the “Tables” list displays in the ____. 

a. Objects bar c. Navigation Pane 

b. Groups bar d. Table Design grid 
 

 

ANS: C PTS: 1 REF: 109 

 

 16. In the view in the accompanying figure, the ____ displays the field properties for the selected field. 



a. Table Design grid c. Objects bar 

b. Field Properties pane d. Groups bar 
 

 

ANS: B PTS: 1 REF: 109 

 

 17. In the view shown in the accompanying figure, you can use the ____ to set the properties for fields that 

do not use the default settings. 

a. Groups bar c. Objects bar 

b. Field Properties pane d. Table Design grid 
 

 

ANS: B PTS: 1 REF: 114 

 

 18. In the view in the accompanying figure, you can press the ____ key to move between the design grid 

and the Field Properties pane. 

a. F2 c. F11 

b. F6 d. F12 
 

 

ANS: B PTS: 1 REF: 114 

 

 19. All of the following can be used in the name of an Access object EXCEPT ____. 

a. dollar sign c. accent grave 

b. period d. square bracket 
 

 

ANS: A PTS: 1 REF: 110 

 

 20. Names of Access objects can contain up to ____ characters. 

a. 16 c. 64 

b. 32 d. 128 
 

 

ANS: C PTS: 1 REF: 110 

 

 21. The default field size for a Text field is ____ characters. 

a. 20 c. 255 

b. 125 d. 256 
 

 

ANS: C PTS: 1 REF: 111 

 

 22. Some developers like to use the ____ property for a field to document its contents, such as identifying 

a field as a primary or foreign key or providing users with instructions about entering values into the 

field. 

a. Name c. Purpose 

b. Description d. Data Type 
 

 

ANS: B PTS: 1 REF: 111 | 112 

 

 23. AutoNumber fields store data using the ____ field size. 

a. Double c. Byte 

b. Long Integer d. Binary 
 

 

ANS: B PTS: 1 REF: 111 

 

 24. A Text field can store ____ characters. 

a. 1 to 255 c. 0 to 255 

b. 256 to 2048 d. 256 to 1024 
 

 

ANS: C PTS: 1 REF: 111 

 



 25. To create a table in Design view, click the ____ tab on the Ribbon and then the Table Design button. 

a. View c. Switch 

b. Design d. Create 
 

 

ANS: D PTS: 1 REF: 112 

 

 26. When entering the data in a table in Datasheet view, you would press the ____ key to cancel a record 

that you have just entered. 

a. Enter c. Tab 

b. Esc d. Delete 
 

 

ANS: B PTS: 1 REF: 113 

 

 27. The ____ property specifies how a field name will appear in different database objects. 

a. Name c. Font 

b. Caption d. Format 
 

 

ANS: B PTS: 1 REF: 116 

 

 28. In Access, you can control the format of a value by creating a(n) ____. 

a. validation rule c. input mask 

b. caption d. format mask 
 

 

ANS: C PTS: 1 REF: 117 

 

 29. An input mask supplies the ____ characters. 

a. masking c. format 

b. caption d. literal 
 

 

ANS: D PTS: 1 REF: 118 

 

 30. The ____ value near the end of an input mask specifies that literal characters in the input mask are to 

be stored in the database. 

a. ;1; c. ;0; 

b. ;; d. ;>; 
 

 

ANS: B PTS: 1 REF: 120 

 

 31. The ____ input mask character indicates that letter entry is required. 

a. ? c. L 

b. 9 d. > 
 

 

ANS: C PTS: 1 REF: 119 

 

 32. In Access, you can specify restrictions on the data that users can enter into a field by creating a(n) 

____. 

a. validation rule c. input mask 

b. caption d. password 
 

 

ANS: A PTS: 1 REF: 121 

 

 33. The ____ property specifies the valid values that users can enter into the field. 

a. Input mask c. Permissions 

b. Validation Rule d. Values 
 

 

ANS: B PTS: 1 REF: 121 

 



 34. If a user attempts to enter an invalid value in a field, the ____ property for the field opens a dialog box 

with a predefined message that explains the valid values. 

a. Input Mask Rule c. Validation Rule 

b. Input Mask Text d. Validation Text 
 

 

ANS: D PTS: 1 REF: 121 

 

 35. The ____ validation rule specifies that the field cannot accept null values. 

a. Text Required c. Not Empty 

b. Is Not Null d. Void 
 

 

ANS: B PTS: 1 REF: 122 

 

 

 

 36. A(n) ____ field like the one in the accompanying figure lets the user select a field value from a list of 

existing field values stored in the database or from a list of values specified when the field was created. 

a. lookup c. validation 

b. input mask d. backup 
 

 

ANS: A PTS: 1 REF: 123 

 

 37. To add a field like the one shown in the accompanying figure to a table, you change the field’s data 

type to ____. 

a. Lookup Rule c. Lookup Mask 

b. Lookup Text d. Lookup Wizard 
 

 

ANS: D PTS: 1 REF: 123 

 

 38. In the table shown in the accompanying figure, the House ID field is a(n) ____ field. 

a. input mask c. validation 

b. lookup d. password-protected 
 

 

ANS: B PTS: 1 REF: 126 

 

 39. Loading tables with data is also known as ____ the database. 

a. populating c. validating 

b. distributing d. coding 
 

 

ANS: A PTS: 1 REF: 132 

 

 40. Hyperlinks in an Excel worksheet will be imported as ____ data by Access. 

a. memo c. number 

b. OLE Object d. text 
 

 

ANS: D PTS: 1 REF: 136 

 

 41. To import an Excel worksheet, the first step is to click the ____ tab on the Ribbon, and then click 

Excel. 



a. External Data c. Spreadsheets 

b. Import d. Data Source 
 

 

ANS: A PTS: 1 REF: 136 

 

 42. The primary objective of creating a(n) ____ field in a table is to prevent users from entering duplicate 

records into the table. 

a. primary key c. input mask 

b. lookup d. validation 
 

 

ANS: A PTS: 1 REF: 141 

 

 43. When a field has no value—a value that is unknown or unavailable or just missing—it is called a ____ 

value. 

a. zero c. null 

b. void d. hidden 
 

 

ANS: C PTS: 1 REF: 141 

 

 44. You can use the ____ property for a nonprimary key field to ensure that users enter a value into the 

field. 

a. Nonnull c. Required 

b. Text d. Validate 
 

 

ANS: C PTS: 1 REF: 141 

 

 45. You might think of a database ____ as a small table containing values from a table and record numbers 

that reference those values. 

a. grid c. glossary 

b. index d. dictionary 
 

 

ANS: B PTS: 1 REF: 142 

 

 46. A(n) ____ does not contain an entire record--it only contains the field from the record and a pointer to 

the record number. 

a. grid c. glossary 

b. index d. dictionary 
 

 

ANS: B PTS: 1 REF: 142 

 

 47. To create an index in a table, open the table in Design view, select the field to index, and then click the 

____ property list arrow. 

a. Add Index c. Indexed 

b. Identify d. Index Rule 
 

 

ANS: C PTS: 1 REF: 142 

 

 48. You can delete an index by right-clicking the index name, and then clicking ____ on the shortcut 

menu. 

a. Delete c. Delete Index 

b. Delete Rows d. Delete Data 
 

 

ANS: B PTS: 1 REF: 143 

 

 49. To view the indexes created in a table, click the ____ button on the Table Design tab on the Ribbon. 

a. Indexes c. View 



b. Show d. Reveal 
 

 

ANS: A PTS: 1 REF: 143 

 

 50. You can add indexes to the Indexes window by typing an index name, field name, and the ____ order. 

a. input c. delete 

b. output d. sort 
 

 

ANS: D PTS: 1 REF: 143 

 

 51. Creating an index can slow down the database because the index must be updated as users ____ 

records. 

a. add c. delete 

b. change d. any of the above 
 

 

ANS: D PTS: 1 REF: 143 

 

 52. In Access, you define table relationships in the ____ window. 

a. Tables c. Database 

b. Relationships d. Datasheet 
 

 

ANS: B PTS: 1 REF: 144 

 

 53. When you click the plus box for a record in a table that has a one-to-many relationship, the ____ 

displays records from the related table. 

a. query c. switchboard 

b. data access page d. subdatasheet 
 

 

ANS: D PTS: 1 REF: 151 

 

 54. ____ mode allows multiple users to open and use the database at the same time. 

a. Open Read-Only c. Open 

b. Open Multi d. Open Exclusive 
 

 

ANS: C PTS: 1 REF: 155 

 

 55. ____ mode is the default option for opening a database. 

a. Open Read-Only c. Open 

b. Open Exclusive d. Open Exclusive Read-Only 
 

 

ANS: C PTS: 1 REF: 155 

 

 56. ____ mode allows multiple users to open a database, but they cannot write any information to the 

database. 

a. Open Read-Only c. Open 

b. Open Exclusive d. Open Exclusive Read-Only 
 

 

ANS: A PTS: 1 REF: 155 

 

 57. ____ mode opens the database so that all users except for the current user are locked out from opening 

and using the database at the same time. 

a. Open Read-Only c. Open 

b. Open Exclusive d. Open Exclusive Read-Only 
 

 

ANS: B PTS: 1 REF: 155 

 



 58. ____ mode opens the database so that all users except for the current user are locked out, but the 

current user can only view the data in the database. 

a. Open Read-Only c. Open 

b. Open Exclusive d. Open Exclusive Read-Only 
 

 

ANS: D PTS: 1 REF: 155 

 

 59. A database administrator uses the ____ option to open the database prior to setting a password or 

database security. 

a. Open Read-Only c. Open 

b. Open Exclusive d. Open Exclusive Read-Only 
 

 

ANS: B PTS: 1 REF: 155 

 

 60. ____ the database refers to the process of recovering unused space in a database. 

a. Backing up c. Compacting 

b. Validating d. Populating 
 

 

ANS: C PTS: 1 REF: 156 

 

 61. The end result of compacting a database is usually a database with ____. 

a. a decreased file size c. decreased efficiency 

b. an increased file size d. the same file size as before 
 

 

ANS: A PTS: 1 REF: 156 

 

 62. The Compact on Close check box is found under the ____ option in the Access options dialog box. 

a. Advanced c. Error Checking 

b. Current Database d. Datasheet 
 

 

ANS: B PTS: 1 REF: 156 

 

 63. In the event of a ____, you may need to restore a copy of the database. 

a. power failure c. user accidentally deleting database objects 

b. hard disk crash d. any of the above 
 

 

ANS: D PTS: 1 REF: 158 

 

 64. In most cases, a backup is created on any of the following EXCEPT ____. 

a. CD c. DVD 

b. USB flash drive d. external hard drive 
 

 

ANS: B PTS: 1 REF: 158 

 

 65. With the Print Table Definition dialog box, you can specify that all of the following EXCEPT ____ be 

printed. 

a. permissions by user and group c. names for indexes 

b. field sizes for fields d. object definitions 
 

 

ANS: D PTS: 1 REF: 160 

 



 

 

 66. The accompanying figure shows a ____. 

a. table in Design view c. report 

b. table in Datasheet view d. query 
 

 

ANS: C PTS: 1 REF: 160 

 

 67. ____ a database with a database converts the data in the database into a format that is unreadable by 

other tools. 

a. Backing up c. Encrypting 

b. Compacting d. Password protecting 
 

 

ANS: C PTS: 1 REF: 161 

 

 68. To set a database password, you type the password in the Password text box, press the Tab key, and 

then type the same password in the ____ text box. 

a. Confirm c. Verify 

b. Reset d. Control 
 

 

ANS: C PTS: 1 REF: 162 

 

 69. A strong password contains at least ____ characters. 

a. four c. six 

b. five d. seven 
 

 

ANS: D PTS: 1 REF: 162 

 

 70. To permanently restore a hidden object, open the ____ dialog box for the object, and then clear the 

Hidden check box. 

a. Attributes c. Control 

b. Properties d. Display 
 

 

ANS: B PTS: 1 REF: 163 

 

Case-Based Critical Thinking Questions 

 

Case 1 

Amitabh is in training to move from his position as a programmer for the company to a role as your 

assistant database administrator. In your first meeting, you are introducing him to the options for 

opening an Access database.  



 

 71. Amitabh needs a given database to allow multiple users to open and use the database at the same time. 

What mode do you advise Amitabh to use? 

a. Open c. Open Exclusive 

b. Open Read-Only d. Open Exclusive Read-Only 
 

 

ANS: A PTS: 1 REF: 155 TOP: Critical Thinking  

 

 72. You want Amitabh to establish a situation in which multiple users can open the Customer database but 

for a period of two days there is a freeze on changes to customer records. During this time, staff 

members should not be able to make any changes to the customer records. What mode should he use to 

open the database? 

a. Open c. Open Exclusive 

b. Open Read-Only d. Open Exclusive Read-Only 
 

 

ANS: B PTS: 1 REF: 155 TOP: Critical Thinking 

 

 73. Having made some key changes to the Customer database, you now want Amitabh to make some 

adjustments to the security of the database, and now you do not want anyone to open the database 

during the hour it will take Amitabh to make the fixes. What mode should he use to open the database? 

a. Open c. Open Exclusive 

b. Open Read-Only d. Open Exclusive Read-Only 
 

 

ANS: C PTS: 1 REF: 155 TOP: Critical Thinking  

 

 74. After Amitabh has made some key security enhancements to the database, he needs to allow one (but 

only one) trusted user to view (but not make any changes to) the records in the database. What mode is 

right for this task? 

a. Open c. Open Exclusive 

b. Open Read-Only d. Open Exclusive Read-Only 
 

 

ANS: D PTS: 1 REF: 155 TOP: Critical Thinking 

 

 75. If Amitabh doesn’t change the option for opening the database, which of the following modes will be 

used by default? 

a. Open c. Open Exclusive 

b. Open Read-Only d. Open Exclusive Read-Only 
 

 

ANS: A PTS: 1 REF: 155 TOP: Critical Thinking 

 

Case-Based Critical Thinking Questions 

 

Case 2 

In his database of thousands of records, Suresh wants to standardize the way that data in certain fields 

displays, but he does not want to take up additional space with the characters (e.g., parentheses, 

dashes, slash characters) that would be used to format the data. For this reason, he wants to use input 

masks and he turns to his friend Sheila because he knows that she has made extensive use of them 

before. 

 

 76. Which of the following is a true statement Sheila can make about this input mask: 00/00/0000;;_? 

a. This input mask accepts only letters. 

b. This input mask displays literal characters. 

c. This input mask ensures that users must enter two-digit years. 

d. None of the above 
 

 

ANS: D PTS: 1 REF: 119 | 120 TOP: Critical Thinking 



 

 77. Which input mask character does Sheila tell Suresh can be used to require that each of the three digits 

of an area code is filled in? 

a. # c. 000 

b. $ d. * 
 

 

ANS: C PTS: 1 REF: 120 TOP: Critical Thinking 

 

 78. Sheila tells Suresh that there is an input mask character that can cause characters entered into the input 

mask to fill from left to right rather than from right to left. What is this character? 

a. ! c. R 

b. > d. 0 
 

 

ANS: A PTS: 1 REF: 119 TOP: Critical Thinking 

 

 79. Suresh wants to make the entry of letters optional in a license plate number field, as not all license 

plates have letters. What is the input mask character Sheila tells him he can use? 

a. L c. P 

b. ? d. ! 
 

 

ANS: B PTS: 1 REF: 119 TOP: Critical Thinking 

 

 80. Suresh wants all of the letters that appear in a license plate to appear as uppercase, but he knows that 

some of his users enter these letters as lowercase letters. Which of the following input mask characters 

is the solution to his problem, according to Sheila? 

a. L c. ? 

b. ! d. > 
 

 

ANS: D PTS: 1 REF: 119 TOP: Critical Thinking 

 
COMPLETION 

 

 1. You can use the ____________________ property to limit the number of characters to store in a Text 

field. 

 

ANS: Field Size 

 

PTS: 1 REF: 110 

 

 2. If you need additional room on your screen, you can click the ____________________ Button to open 

or close the Navigation Pane.  

 

ANS:  

Shutter Bar Open/Close 

Shutter bar open/close 

Shutter Bar open/close 

 

PTS: 1 REF: 107 

 

 3. Instead of changing a field name, you can use the ____________________ property for a field to 

change the way the field name is displayed. 

 

ANS: Caption 

 



PTS: 1 REF: 116 

 

 4. In Access, you can create an input mask for a field by using the ____________________ Wizard.  

 

ANS: Input Mask 

 

PTS: 1 REF: 118 

 

 5. A(n) ____________________ rule compares the data entered by the user against one or more valid 

values that the database developer specified using the Validation Rule property for the field.  

 

ANS: validation 

 

PTS: 1 REF: 121 

 

 6. The ____________________ property enters a default value into any type of field except for an 

AutoNumber field. 

 

ANS: Default Value 

 

PTS: 1 REF: 122 

 

 7. The ____________________ property for a nonprimary key field can be used to make sure that users 

enter a value into the field. 

 

ANS: Required 

 

PTS: 1 REF: 141 

 

 8. As a database grows, its indexes might slow down the database and make ____________________ 

take longer. 

 

ANS:  

creating records 

modifying records 

deleting records 

 

PTS: 1 REF: 143 

 

 9. To open the Relationships window, click the ____________________ button on the Database Tools 

tab of the Ribbon. 

 

ANS: Relationships 

 

PTS: 1 REF: 144 

 

 10. To view the properties for a relationship, you can right-click the join line, and then click 

____________________ on the shortcut menu.  

 

ANS: Edit Relationship 

 

PTS: 1 REF: 144 

 

 11. Most organizations assign the tasks of maintaining a database to ____________________.  



 

ANS:  

database administration 

database administrators 

a database administrator 

a DBA 

DBA 

DBAs 

 

PTS: 1 REF: 154 

 

 12. To change the way you open a database, click the File tab, select the ____________________ 

command, and then choose the location and file you want to open. 

 

ANS: Open 

 

PTS: 1 REF: 154 

 

 13. When you are deciding how to open a database, Access may give the option to 

____________________ in order to open previous versions of the database file.  

 

ANS:  

Show previous versions 

show previous versions 

 

PTS: 1 REF: 155 

 

 14. The process of recovering unused space in a database is known as ____________________ the 

database. 

 

ANS: compacting 

 

PTS: 1 REF: 156 

 

 15. To compact a database, click the File tab, select the Info tab, and then click 

______________________________. 

 

ANS:  

Compact and Repair 

Compact & Repair 

Compact & repair 

compact & repair 

 

PTS: 1 REF: 156 

 

 16. ____________________ a database creates a copy of the database that you can restore in the event of 

a loss. 

 

ANS: Backing up 

 

PTS: 1 REF: 158 

 

 17. To back up a database, click the File tab, click the Share tab, clicks and then click 

____________________. 



 

ANS:  

Save Database 

Save database 

save database 

 

PTS: 1 REF: 158 

 

 

 

 18. The ____________________ tool, as shown in the accompanying figure, can be used to create a report 

of every object or just selected objects in a database.  

 

ANS:  

Database Documenter 

Database documenter 

database documenter 

 

PTS: 1 REF: 159 

 

 19. You can use the Print button on the Print ____________________ tab on the Ribbon to print a report.  

 

ANS:  

Preview 

preview 

 

PTS: 1 REF: 160 

 

 20. The easiest way to secure a database from unauthorized use is to set a(n) ____________________.  

 

ANS: password 

 

PTS: 1 REF: 161 

 
MATCHING 

 

Identify the letter of the choice that best matches the phrase or definition. 

a. input mask h. Database Documenter tool 



b. 0 i. Field Properties pane 

c. index j. null 

d. Table Design grid k. password 

e. Caption property l. DBA 

f. Validation Rule property m. 9 

g. Database window 
 

 

 1. The main control panel for the database. 

 

 2. The kind of value that is unknown, unavailable, or just missing.  

 

 3. Input mask  character that requires an entry of a digit from 0 to 9 only.  

 

 4. The top part of Design view. 

 

 5. The bottom part of Design view.  

 

 6. A predefined format that you can apply to a field so that its values are stored using the format you 

specified. 

 

 7. Specifies the valid values that users can enter into the field. 

 

 8. A list maintained by the database (but hidden from users) that associates the field values in the indexed 

field with the records that contain the field values. 

 

 9. A group or individual that is responsible for designing, maintaining, and securing the database. 

 

 10. Produces a report of every object or just selected objects in a database.  

 

 11. A collection of characters that a user types to gain access to a file.  

 

 12. Used for changing the way a field name is displayed. 

 

 1. ANS: G PTS: 1 REF: 107 

 

 2. ANS: J PTS: 1 REF: 141 

 

 3. ANS: B PTS: 1 REF: 119 

 

 4. ANS: D PTS: 1 REF: 109 

 

 5. ANS: I PTS: 1 REF: 109 

 

 6. ANS: A PTS: 1 REF: 117 

 

 7. ANS: F PTS: 1 REF: 121 

 

 8. ANS: C PTS: 1 REF: 142 

 

 9. ANS: L PTS: 1 REF: 154 

 

 10. ANS: H PTS: 1 REF: 159 

 

 11. ANS: K PTS: 1 REF: 161 

 

 12. ANS: E PTS: 1 REF: 116 

 
ESSAY 

 

 1. List the steps to import spreadsheet data into an existing table.  

 

ANS:  

1. Create and save the table in Access and then close it. 

2. Examine the source data and make sure that the columns are arranged in the same order as the fields 

in the table, make any necessary changes, and then close the spreadsheet file. 

3. In the Access Database window, click the External Data tab on the Ribbon and then click Excel. The 

Get External Data -- Excel Spreadsheet dialog box opens. 

4. Browse to the folder or drive that contains the file to import, select the source file, click the Open 

button, select Append a copy of the records to the [tablename], if necessary, and then click OK to start 

the Import Spreadsheet Wizard. 

5. If necessary, select the worksheet or named range that contains the data to import and then click the 

Next button. 



6. If necessary, click the First Row Contains Column Headings check box to indicate that the first row 

in the source file contains headings, and then click the Next button. 

7. If necessary, click the In an Existing Table option button, click the list arrow, click the table into 

which to import the data, and then click the Next button. 

8. Verify that the table name to import is correct and then click the Finish button. 

9. Click the Close button to close the wizard. 
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 2. Discuss what is meant by compacting a database and why this process is needed.  

 

ANS:  

As users work in a database by adding and deleting records and objects, the size of the database 

increases and decreases. However, the space created by deleting a record or object is not automatically 

recovered for use by records and objects that users add to the database. Just like any other computer 

file, a database becomes large with blocks of unused space. These unused areas can ultimately increase 

the database size and make it inefficient. The process of recovering unused space in a database is 

known as compacting the database. When you compact a database, the data and objects in the database 

are reorganized and unused spaces are reassigned and deleted. The end result is usually a database with 

a decreased file size and improved efficiency.  
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 3. Define strong password and discuss choosing a strong password. 

 

ANS:  

Strong passwords are character strings that contain at least seven characters consisting of combinations 

of uppercase and lowercase letters, numbers, and symbols. When creating a strong password for a 

database, it is important to select a password that is easy to remember so it is easy to use. However, 

some users choose passwords that are easy to remember but are also very easy for another person to 

guess, such as the name of a pet, child, or spouse or a date of birth or anniversary. Random collections 

of characters are much harder to guess or break because the combination of characters is not a word. In 

any program that requests a password, choose a strong password over one that is a simple word. Even 

if your password is 5&uJK#8, you will learn it quickly if you type it frequently. It is always best with 

sensitive databases to require logins and passwords to access the database or perhaps keep it on a 

separate workstation. 
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